
TEAM 540
Release Notes, Version 2.1.0 for HPOV - SUN Solaris
058R638-V210, Issue 3 - March 2001



Warranty

General DataComm warrants that its equipment is free from defects in materials and workmanship.  The warranty
period is one year from the date of shipment.  GDC's sole obligation under its warranty is limited to the repair or
replacement of the defective equipment provided it is returned to GDC, transportation prepaid, within a reasonable
period.  This warranty will not extend to equipment subjected to accident, misuse, or alterations or repair not made
by GDC or authorized by GDC in writing.  The foregoing warranty is exclusive and in lieu of all other warranties,
express or implied, including but not limited to, warranties of merchantability and fitness for purpose.

Trademarks and Patents
General DataComm, the General DataComm logo and the following are trademarks of General DataComm, Inc in
the United States and other countries: ACCULINE, ANALOOP, AUTOFRAME, BERT 901, DATACOMM
SECURE-PAK, DATALOOP, DIGIDIAL, ENmacs, FASTPRO, FIRST RESPONSE, GDC, GDC APEX,
GENERAL DATACOMM X-PRESS, GEN*NET, GEN*PAC, IMAGE*TMS, KILOMUX,  LAN*TMS,
MEGA*BRIDGE, MEGAMUX, MEGAMUX TMS,  MEGANET, MEGASPLIT, MEGASWITCH, MEGAVIEW,
NETCON, NETSWITCH, NMC, QUIKSHIPPERS, SERVI-CHECK, SERVI-SNAP, WINmacs.

ANALOOP and DATALOOP respectively are protected by U.S. patents 3,655,915 and 3,769,454.  All other products
or services mentioned in this document are identified by the trademarks, service marks, or product names as
designated by the companies who market those products.  Inquiries concerning such trademarks should be made
directly to those companies.

Copyright
© 2001 General DataComm, Inc.  All rights reserved.
P.O. Box 1299, Middlebury, Connecticut 06762-1299 U.S.A.

This publication and the software it describes contain proprietary and confidential information.  No part of this
document may be copied, photocopied, reproduced, translated or reduced to any electronic or machine-readable
format without prior written permission of General DataComm, Inc.

The information in this document is subject to change without notice.  General DataComm assumes no responsibility
for any damages arising from the use of this document, including but not limited to, lost revenue, lost data, claims by
third parties, or other damages.  If you have comments or suggestions concerning this manual, please write to
Technical Publication Services or call 1-203-758-1811.



TEAM 540 Version 2.1.0  Publication No. 058R638-V210
Issue 3 - March 2001

Releas

TABLE OF CONTENTS
... 5

......

...6

.......6

...

.....6

.....6

.....6

....7

...9

.15

.

.16

...18

..

....18

....19

...20

..22

24

..24

25

...25
Section 1 - Solaris ..............................................................................
1.0 Overview ......................................................................................................................... 5
2.0 Software Reference.....................................................................................................5

2.1 TEAM 540 Verification.....................................................................................

3.0 Improvements Since Last Release .............................................................................

4.0 Corrected Issues.............................................................................................................6

5.0 HP OpenView for Solaris ............................................................................................

5.1 Hardware Requirements ..................................................................................

5.2 Software Requirements....................................................................................

5.3 First Time Installation.......................................................................................

5.4 Installing in a Solaris Distributed Environment ................................................

5.5 Post-Installation Procedure For All Solaris Environments................................

6.0 De-Installation ...............................................................................................................15

6.1 De-Installing a Distributed Environment...........................................................

6.2 Re-Installation..................................................................................................

7.0 Known Issues................................................................................................................18

8.0 Operating Guidelines ..................................................................................................

Section 2 - TEAM Applications and HP OpenView NNM
Scalable and Distributed Environments ................................. 19

1.0 Overview.........................................................................................................................19

1.1 Features and Advantages ................................................................................

1.2 Theory of Operation.........................................................................................

1.3 The Distribution of Processes and Applications...............................................

2.0 Integrating the TEAM Application in a Distributed Environment .................................

2.1 TEAM Software Product Dependency .............................................................

2.2 Discovery in an HP OpenView Distributed Environment..................................

2.3 Event Handling ................................................................................................
e Notes for GDC Part No. 058U704-C01A Page 3



Publication No. 058R638-V210 TEAM 540 Version 2.1.0
Issue 3 - March 2001

Page 4
 Release Notes for GDC Part No. 058U704-C01A



TEAM 540 Version 2.1.0 Publication No. 058R638-V210
Issue 3 - March 2001

Releas

of the 
0 

 6.1 
ates, 

e 
ant 
Section 1 - Solaris

1.0 Overview 
These installation and release notes provide new information relevant to this version 
TEAM 540 software product. This updates the information supplied by the TEAM 54
Operation Manual. If you require additional details please refer to that manual.

Team 540 is now supported on the following Solaris platforms: Solaris 2.7 with HPOV
and Solaris 2.8 with HPOV 6.1. For additional product information and the latest upd
check the GDC website at http://www.gdc.com  or contact your GDC field 
representative. 

2.0 Software Reference
Throughout this manual, short forms of the software product names will be used. Th
following tables provide detailed reference information for all software modules relev
to TEAM 540 for Solaris installation. 

Table 1:  Software Reference for Solaris 

Item Part Number/Description Version / Release

TEAM 540 Software Product 058U604-C01A Ver 2.1.0

TEAM 540 
Operation Manual

058R694-V210 Issue 1

Solaris Software Product S-058U019-C01 Ver 2.7 / Nov 1999 

S-058U020-0001 Ver 2.8 / Feb 2000 Ver A

HPOV for Solaris 
Software 
Product

Full: 759-065S002 (Enterprise)
Entry 759-065S003 (250 Node)

Ver 6.1 

Solaris/HPOV 
Patch Clusters

Ref: Sun / HP websites

HPOV Network Node Man-
ager Installation Guide

HP J1136-9000

Table 2: TEAM 540 Software Packages

Package Name Description Version

GDCTeam GDC TEAM Utilities Ver 1.1 or higher

GDCTeamSA GDC Standalone Utilities Ver 1.0 or higher

GDCa540 GDC Standalone TEAM 540 Ver 2.1 or higher
e Notes for GDC Part No. 058U704-C01A Page 5
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2.1 TEAM 540 Verification
The TEAM 540 CD contains the software packages listed in the table above. After 
installation is completed, these packages should be present on the system at the ve
indicated in the table or greater. To verify the presence of the TEAM 540 packages 
currently installed type the following command:

/usr/bin/pkginfo -1 <PackageName>

3.0 Improvements Since Last Release
This is the initial release of TEAM 540 software. This software has been tested to be
2000 compliant in accordance to GDC ENG-STD-003. Check GDC's web site at 
http://www.gdc.com for the latest Year 2000 information. Note the following new 
information concerning this software:

• The application is approved for operation on SUN Solaris 2.7, Solaris 2.8, HP 
OpenView 6.1 and HPUX 11.0 upgrades. 

4.0 Corrected Issues
None.

5.0 HP OpenView for Solaris
The following sections describe the current requirements and procedures concernin
HP OpenView for Solaris version of TEAM 540 software.

5.1 Hardware Requirements
The current hardware requirements for TEAM 540 software is as follows:

• Minimum disk space requirements:

/opt 60 megabytes

• The graphics card should support a resolution of 1152x900

• SUN ULTRA 5 or greater with a minimum of 96 megabytes of RAM, 2 gigabytes
hard disk space, 350 megabytes of disk space and 192 megabytes of swap spac

• CD ROM Drive

Note: For information on hardware requirements for HP OpenView Network Node Manage
products, refer to the HP OpenView Network Node Manager Products Installation G

5.2 Software Requirements
Before installing this version of TEAM 540, the following software must be installed. Re
to Table 1: Software Reference for Solaris, for detailed identification of all software 
products discussed below. 

• Solaris Software

• HP OpenView for Solaris, Entry or HP OpenView for Solaris, Full
Release Notes for GDC Part No. 058U704-C01A
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• TEAM 540 software packages

Note: IMPORTANT - It is highly recommended that the customer download and install the l
SOLARIS PATCH CLUSTER from the following Sun web site: http://sunsolve.sun.co
This will ensure that you have updated the Operating System along with any current
to reported problems.

Note: IMPORTANT - It is highly recommended that the customer download and install the l
HP OPENVIEW CONSOLIDATED PATCH CLUSTER from the following HP web sit
http://ovweb.external.hp.com/cpe/patches. This will ensure that you have updated H
OpenView along with any current fixes to reported problems.

5.3 First Time Installation
To install the current TEAM 540 software, 

1. Make sure that all users exit HP OpenView for Solaris.

2. Insert the TEAM 540 Compact Disk into the CD ROM drive.

3. At a shell prompt become super-user by entering the following command:

su

4. To stop HP Open View, type:

opt/OV/bin/ovstop

5. Start the installation process by entering the following commands:

cd /cdrom/cdrom0

6. If a version of the TEAM 540 is already resident on the workstation, or if you are
sure if it is resident, enter the following command before attempting to install the 
version:

./remove

Ignore any error messages that may appear and answer y  for the questions.

7. Continue the installation process by entering the following command:

./install

Answer y  for the questions. The loading of software will take a few minutes.

8. Start HP Open View by typing: 

/opt/OV/bin/ovstart  
9. Exit super-user (type exit ).

10. Remove the CD from the CD ROM drive.
e Notes for GDC Part No. 058U704-C01A Page 7
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5.3.1 Updating Common Desktop Environments
1. Open the $HOME/.dtprofile  file with your editor and read the lengthy commen

that are included in it. The comments provide information on:

A. how to use the C (csh), Bourne (sh), and Korn (ksh) shells in the CDE

B. which terminal commands should not be used because they can prevent logi
When using the csh shell, the commands are generally present in .login  and 
.cshrc files. When using the sh or ksh shells, they are in .login  and .pro-
file  files.

2. After reviewing the comments, edit the $HOME/.dtprofile  file to remove the 
leading pound sign(s) in the line that contains

### DTSOURCEPROFILE=true

3. If you are using C (csh) Shell you must add the following lines to $HOME/.cshrc :

source   /opt/OV/bin/ov.envvars.csh

set path=($path   $OV_BIN)

4. If you are using Bourne(sh) shell or Korn(ksh) shell you must add the following l
to $HOME/.profile :

. /opt/OV/bin/ov.envvars.sh

PATH=$PATH:$OV_BIN; export PATH

5. The Common Desktop Environment is now updated for all users. Complete the
installation by typing:

/opt/OV/bin/ovw &

6. For the changes to take effect, you must now logout and login.

5.3.2 Updating Sun OpenWindows Environments
1. If you are using C (csh) Shell you must add the following lines to $HOME/.cshrc :

source   /opt/OV/bin/ov.envvars.csh

set path=($path   $OV_BIN)

2. If you are using Bourne(sh) shell or Korn(ksh) shell you must add the following l
to $HOME/.profile :

. /opt/OV/bin/ov.envvars.sh

PATH=$PATH:$OV_BIN; export PATH

3. The Sun OpenWindows environment is now updated for all users. Complete the
installation by typing:

/opt/OV/bin/ovw &

4. You must now logout and login in order for the changes to take effect.
Release Notes for GDC Part No. 058U704-C01A
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5.4 Installing in a Solaris Distributed Environment
A distributed environment consists of three types of workstations. Not all workstation
require installation of all software, but the workstations must be set up in the followin
order: 

A. Collection Station

B. Management Station

C. Management Console

The procedures for TEAM 540 and product software installation vary depending on t
type of workstation. Perform the installation and set up procedures for each workstat
your distributed environment. 

5.4.1 Setting up Collection Stations
On workstations that serve as collection stations, you must install the TEAM softwar
described in the previous paragraphs, and then configure events so that traps are for
to the management station. Refer to the event data in the table below during this insta
process. 

Note: Refer to Section 2 for detailed information on TEAM Applications in HPOV NNM 
Scalable and Distributed Environments. For detailed information on Event Forwardin
refer to the HP OpenView Guide to Scalability and Distribution for Network Node 
Manager. 

1. Become a super user by typing su  and suppling the super user password.

2. Perform the procedures for a Basic Installation as described above.

3. Start the Event system configurator GUI by typing:

$OV_BIN/xnmtrap

4. From the Enterprise Identification panel, select an Enterprise Name

for example: gdc_cmnAlarm

5. From the Event Identification panel, select an Event Name

for example: dmscmnAlarmTrap

6. From the Event Configuration window menu bar, select Edit->Modify Event . 
The Event Configurator/Modify Event dialog box appears.

Table 3: Event Forwarding Data

Enterprise Name (Enterprise ID) Event Name (Enterprise Identifier)

gdc_540(.1.3.6.1.4.1.498.8.4) snmp540ColdStart(.1.3.6.1.6.3.1.1.5.1)

gdc_540(.1.3.6.1.4.1.498.8.4) snmp540WarmStart(.1.3.6.3.1.1.5.2)

gdc_540(.1.3.6.1.4.1.498.8.4) snmpLinkDown(.1.3.6.1.6.3.1.1.5.3)

gdc_540(.1.3.6.1.4.1.498.8.4) snmpLinkUp(.1.3.6.1.6.3.1.1.5.4)

gdc_540(.1.3.6.1.4.1.498.8.4) snmp540Authentication(.1.3.6.1.6.3.1.1.5.5)
e Notes for GDC Part No. 058U704-C01A Page 9
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7. Click on the Forward Event check box to expand the dialog box. The Forwarded E
Destinations pane displays.

8. Type the hostname or IP Address for destination. Destinations are the managem
stations to which events will be forwarded. 

9. Repeat steps 5 through 9 for each of the events listed in Table 3.

10. When all events are forwarded, click OK in the Event Configurator/Modify Event 
dialog box.

11. At the Event Configuration window, click File->Save  to save the changes.

12. To cause Openview processes to re-read the trapd.conf file, generate Event by t

$OV_BIN/xnmtrap -event

5.4.2 Installing TEAM Applications on the Management Station
To install TEAM 540 on the Management Station, perform the following steps:

1. Make sure all users exit HP OpenView for Solaris.

2. To install TEAM 540, insert the TEAM 540 CD into the CD ROM drive.

3. At the shell prompt, become super user by typing

su

4. Check /  to make sure there is a /cdrom  directory already present. If not, create it.

5. Stop HP OpenView processes by typing 

/opt/OV/bin/ovstop 

6. Start the installation process by typing:

cd /cdrom/cdrom0

7. If a version of the TEAM 540 is already resident on the workstation, or if you are
sure if it is resident, enter the following command before attempting to install the 
version:

./remove

Ignore any error messages that may appear on the monitor and answer y for the 
questions.

8. Continue the installation process by entering the following command:

./install

9. Answer Y to the questions. 

10. When installation is complete, start HP OpenView processes by typing:

/opt/OV/bin/ovstart 

11. Type cd /

12. Type eject  

13. Exit super user by typing exit . Remove the CD from the CD ROM drive.
0 Release Notes for GDC Part No. 058U704-C01A
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5.4.3 Setting Up the Management Station
1. At the shell prompt, become super user by typing

su

2. Type the following commands:

/opt/OV/bin/ovstop

/etc/init.d/nfs.client stop

/etc/init.d/nfs.server start

3. To ensure the NFS server daemon process nfsd  is running, type the following 
command and verify the results:

ps -ef | grep nfsd

4. To add all Management Consoles to the management station, edit the /etc/hosts 
file by typing each Console’s specific IP address and Hostname on a separate li
shown in the example:

###.###.###.### Console_Hostname

###.###.###.### Console_Hostname
5. Save and close the /etc/hosts file . 

Note: If using vi editor, use wq!  to save and close the file.

6. For the Management Console system to share the management station directori
NFS, edit  /etc/dfs/dfstab file as follows:

share -F nfs -o root= Console_Hostname /etc/opt/OV/share
share -F nfs -o root= Console_Hostname /var/opt/OV/share
share -F nfs -o root= Console_Hostname /usr/tmp

7. Save and close the /etc/dfs/dfstab  file.

8. To share the Management Station directories with the Consoles over NFS, type

share -F nfs -o root= Console_Hostname /etc/opt/OV/share
share -F nfs -o root= Console_Hostname /var/opt/OV/share
share -F nfs -o root= Console_Hostname /usr/tmp

9. Edit the /etc/opt/OV/share/conf/ovwdb.auth file as shown below to add
an entry for the Console, as shown in the example: 

Console_Hostname +

10. Edit the /etc/opt/OV/share/conf/ovw.auth file as shown below to add an
entry for the Console, as shown in the example: 

Console_Hostname +

Note: Repeat step 6 through step10 using the specific hostname for each additional Manag
Console in the system.
e Notes for GDC Part No. 058U704-C01A Page 11
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11. Type the following command to restart nfs server.

/etc/init.d/nfs.server stop

/etc/init.d/nfs.server start

12. To start HP Openview processes, type:

/opt/OV/bin/ovstart

13. Exit super user by typing exit .

14. Complete the setup by typing:

/opt/OV/bin/ovw &

5.4.4 Installing TEAM Applications on Management Consoles
To install TEAM 540 on Management Consoles, perform the following steps:

1. Make sure all users exit HP OpenView for Solaris.

2. On the Management Console, become a super user by typing:

su

If the Solaris distributed environment has been set up, perform steps 3- 7. 
Otherwise, skip to step 8.

3. Disconnect as a HP OpenView client by running:

/opt/OV/bin/ovwsetupclient -u

4. Open the file /etc/vfstab and type a # in the beginning of each line to commen
them out. Save and close the file.

5. On the Management Station, become a super user and open the /etc/dfs/dfstab  
file. Comment out each line which contains the Console hostname by typing a # in the 
beginning of each line. 

6. Save and close the /etc/dfs/dfstab file.

7. On the Management Console become a super user and enter the following comm

/etc/umount Station_Hostname:/etc/opt/OV/share

/etc/umount Station_Hostname:/var/opt/OV/share

/etc/umount Station_Hostname:/usr/tmp

8. Check /  to make sure there is a /cdrom  directory already present. If not, create it.

9. Stop HP OpenView processes by typing 

/opt/OV/bin/ovstop 

10. Insert the TEAM 540 Compact Disk into the CD ROM drive.

11. Start the installation process by typing:

cd /cdrom/cdrom0
2 Release Notes for GDC Part No. 058U704-C01A
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12. If a version of the TEAM 540 is already resident on the workstation, or if you are
sure if it is resident, enter the following command before attempting to install the 
version:

./remove

Ignore any error messages that may appear on the monitor and answer y for the 
questions.

13. Continue the installation process by entering the following command:

./install.sh

14. Answer Y to the questions. 

15. When installation is complete, start HP OpenView processes by typing:

/opt/OV/bin/ovstart 

16. Type cd /

17. Type eject  

18. Exit super user by typing exit . Remove the CD from the CD ROM drive.

Perform steps 19 - 25 only if the Solaris distributed environment has been set
Otherwise, skip to step 26.

19. On the Management Station become a super user by typing:

su

20. Open the /etc/dfs/dfstab  file. Remove the # in the beginning of each line 
which contains the Console hostname. 

21. Type the following commands:

share -F nfs -o root= Console_Host_Name /etc/opt/OV/share

share -F nfs -o root= Console_Host_Name /var/opt/OV/share

share -F nfs -o root= Console_Host_Name /usr/tmp

Note: You will now mount /usr/tmp  on the client from the server over nfs, since the TEAM
Shelf Discovery process stores the discovered shelf GUI images (gif files) in /usr/tm

22. On the Management Console become a super user by typing

su

23. Open the file /etc/vfstab and restore each line by deleting the # in the beginning 
of each line. 

24. Save and close the file.

25. Type the following commands:

/etc/mount Station_Hostname:/etc/opt/OV/share

/etc/mount Station_Hostname:/var/opt/OV/share

/etc/mount Station_Hostname:/usr/tmp

/opt/OV/bin/ovwsetupclient /opt/OV/nfs/ Station_Hostname
e Notes for GDC Part No. 058U704-C01A Page 13
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Note: The path many be different if automounter was used.

26. Exit super user and become a normal user. On the management console, bring
OpenView windows using the server database by typing:

/opt/OV/bin/ovw &

5.4.5 Setting Up the Management Console
1. At the shell prompt, become super user by typing

su

2. Type the following commands

/opt/OV/bin/ovstop

/etc/init.d/nfs.server stop

/etc/init.d/nfs.client start

3. To ensure that the NFS client daemon processes (statd and lockd) are running, ty
following command and verify its results:

ps -ef | grep statd

ps -ef | grep lockd

4. To add the Management Station to the Management Console, edit the /etc/hosts 
file by typing the Management Station’s specific IP address and Hostname, as s
in the example:

###.###.###.### Station_Hostname
5. Save and close the /etc/hosts file.

6. Type the following commands:

mkdir -p /opt/OV/nfs/ Station_Hostname/etc/opt/OV/share

mkdir -p /opt/OV/nfs/ Station_Hostname/var/opt/OV/share

rmdir /usr/tmp

mkdir -p /usr/tmp

chmod 777 /usr/tmp

7. To mount the Management Station directories on this Console over NFS, edit th 
/etc/vfstab file as shown in the example:

Station_Hostname:/etc/opt/OV/share - /opt/OV/nfs/ Station_Hostname/etc/opt/OV/share/ nfs - yes rw
Station_Hostname:/var/opt/OV/share - /opt/OV/nfs/ Station_Hostname/var/opt/OV/share/ nfs - yes rw
Station_Hostname:/usr/tmp - /usr/tmp nfs - yes rw

8. Save and close the /etc/vfstab file.
4 Release Notes for GDC Part No. 058U704-C01A
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9. To mount the Management Station directories on this Console over NFS, type t
following commands:

/etc/mount Station_Hostname:/etc/opt/OV/share

/etc/mount Station_Hostname:/var/opt/OV/share

/etc/mount Station_Hostname:/usr/tmp

10. Type the following commands to restart nfs client

/etc/init.d/nfs.client stop

/etc/init.d/nfs.client start

11. Set up the Management Console by typing:

/opt/OV/bin/ovwsetupclient /opt/OV/nfs/ Station_Hostname
12. Exit Super User by typing exit .

13. Complete the setup by typing:

/opt/OV/bin/ovw &

Note: It is not necessary to start HP OpenView daemons using /opt/OV/bin/ovstart on the 
Management Console because the Console shares the same HP OpenView databa
present on the Management Station over NFS.

Note: If the Console OpenView windows does not start up properly, reboot the Manageme
Station and wait until it is UP completely. Then, reboot the Console.

5.5 Post-Installation Procedure For All Solaris Environments
Once the TEAM 540 software has been installed in the desired environment, the follo
procedure must be performed to enable IP Discovery.

1. After completing installation and environment setup, open the root map.

2. At the Options menu, select Network Polling Configuration: IP .

3. At the Configuration Area, select IP Discovery . 

4. Enable the Discover New IP Nodes  option by selecting its checkbox.

5. Click OK. Discovery will begin at once and the Universe map will start to show th
discovered shelves.

6.0 De-Installation
To remove TEAM 540 software:

1. Make sure that all users exit HP OpenView for Solaris.

2. Insert the TEAM 540 Compact Disk into the CD ROM drive.

3. At a shell prompt, become super-user.

4. To stop HPOpen View, type:

/opt/OV/bin/ovstop 
e Notes for GDC Part No. 058U704-C01A Page 15
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5. Start the removal process by entering the following command:

cd /cdrom/cdrom0/solaris

./remove.sh

6. To start all HP Open View, type

/opt/OV/bin/ovstart

7. Exit super-user (type exit ).

8. Remove the CD from the CD ROM drive.

6.1 De-Installing a Distributed Environment
De-installation of TEAM software in a distributed Solaris environment should be 
performed in the following order: 

A. Management Console

B. Management Station

C. Collection Station

6.1.1 De-Installing the Management Console 
To remove TEAM 540 or any other TEAM product software from a management con
perform the following steps:

Note: If the Solaris distributed environment has been set up, it must be disabled temporari
avoid sharing conflicts with the server. Additional steps for this are provided below.

1. Make sure that all users exit HP OpenView for Solaris.

2. At the shell prompt, become super user by typing:

su

3. Disconnect as a HP OpenView client by running:

/opt/OV/bin/ovwsetupclient -u

4. Stop the HP OpenView processes by typing:

opt/OV/bin/ovstop

5. Open the file /etc/vfstab and type a # in the beginning of each line. 

6. Save and close the /etc/vfstab file.

7. On the Management Station, become a super user and open the /etc/dfs/dfstab 
file. Comment out each line which contains this Console by typing a # in the beginning 
of that line.

8. Save and close the /etc/dfs/dfstab file.

9. On the Management Console, become a super user and enter the following com

/etc/umount Station_Hostname:/etc/opt/OV/share

/etc/umount Station_Hostname:/var/opt/OV/share

/etc/umount Station_Hostname:/usr/tmp
6 Release Notes for GDC Part No. 058U704-C01A
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ands, 
10. Begin the removal process by entering the following command:

cd /cdrom/cdrom0

./remove

11. Insert the TEAM 540 CD into the CD ROM drive.

12. Restart all HP OpenView processes by typing:

opt/OV/bin/ovstart

13. Type cd /

14. Type eject  

15. Remove the CD from the CD ROM drive.

16. Open the /etc/vfstab  file and remove the # from the beginning of each line that
contains a Console hostname.

17. On the Management Station, become a super user by typing:

su

18. Open the /etc/dfs/dfstab file and remove the # from any lines which contain 
this Console’s name.

19. Type the following commands:

share -F nfs -o root= Console_Hostname /etc/opt/OV/share
share -F nfs -o root= Console_Hostname /var/opt/OV/share
share -F nfs -o root= Console_Hostname /usr/tmp

20. Exit super user by typing exit . 

21. On the Management Console, become a super user by typing su  and supplying the 
super user password.

22. Attach the NFS mounts to the management console, execute the following comm
using the management station’s host name:

/etc/mount Station_Hostname:/var/opt/OV/share

/etc/mount Station_Hostname:/etc/opt/OV/share

/etc/mount Station_Hostname:/usr/tmp

23. Exit super user login.

6.1.2 De-Installing the Management and Collection Stations 
1. In the OpenView Root map, click on the Standalone universe icon.

2. From the Edit menu of the Root map menu bar, select Delete , then select From 
All Submaps  to remove the Standalone icon from the Root map. 

3. Make sure that all users exit HP OpenView for Solaris.

4. Insert the TEAM 540 CD into the CD ROM drive.

5. At the shell prompt, become super user by typing:

su

6. Stop the HP OpenView processes by typing:

opt/OV/bin/ovstop
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7. Begin the removal process by entering the following command:

cd /cdrom/cdrom0

./remove

8. Restart all HP OpenView processes by typing:

opt/OV/bin/ovstart

9. Type cd /

10. Type eject  

11. Exit super user by typing exit . 

12. Remove the CD from the CD ROM drive.

6.2 Re-Installation
To re-install TEAM 540 software, it is necessary to first perform all the steps in the D
installation procedure. This removes all TEAM 540 packages. You can then repeat the
of the Installation Procedure described earlier in this chapter. You will not need to re
the user environment update procedure.

7.0 Known Issues
• The keyboard Num Lock or Caps Lock  key, if pressed ON will make the mouse

buttons and the scroll bars inoperable.

• In some TEAM application windows, slight text misalignments may appear. Thes
not affect the usability or operation of the application.

• Some TEAM applications may display meaningless characters in the application
window headings. This is due to a font conflict which can be resolved by typing t
following on the command line before running ovw:

xrdb -merge /opt/OV/bin/gdc_load_resources

8.0 Operating Guidelines
• Because the read-only maps are not automatically updated, use Map -> Refresh M

update the maps.

• After an installation of the TEAM software or a reboot of the system, TEAM 
applications may take up to one minute to start up, due to the loading of the shar
libraries.

• After an installation of TEAM software, the user must enable Discover New IP 
Nodes  from the root map Options menu in order for shelf discovery to occur. 
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Section 2 - TEAM Applications and HP OpenView NNM
Scalable and Distributed Environments

1.0 Overview
This section briefly discusses the Scalability and Distribution features in NNM and ho
integrate/install TEAM applications in a Scalable and Distributed environment. Refer t
HP OpenView Manual, “A Guide to Scalability and Distribution for NNM” for more 
detailed understanding and concepts.

1.1 Features and Advantages
The Scalable and Distribution features of the HP OpenView NNM provide robust 
performance over a wide range of network sizes and degrees of complexity. 

The Scalable feature gives NNM the potential for handling networks of different size
both LAN and WAN environments. To make NNM scalable, the network manageme
work load must be distributed to multiple systems. Then, the Distribution feature impr
performance of NNM in large networks by reducing the amount of management traffic
network resources.

Some of the advantages of these NNM features are:

• The Scalable feature of NNM makes it easier to adapt network management for 
handling new networking landscapes.

• The Distribution feature minimizes the amount of network management traffic. 
Without this capability, it would be impractical to monitor thousands of nodes from
single workstation.

• Faster response times and better performance as work load is distributed to mul
workstations.

• Shared responsibilities reduces the risk of losing network management data in the
of an unexpected shutdown of the management station.

• One Common network management database (in most cases) for all users, so th
modifications of managed nodes would be reflected across the board.

Some drawbacks/trade-offs are:

• Distribution of tasks requires an increased number of computing resources.

• Scalable and distributed environment requires added complexity in setup.
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1.2 Theory of Operation
In a Stand-alone environment, all network management tasks are done on a single 
workstation. In a Distributed environment tasks are handled by multiple workstations
Collection Station (CS), Management Station (MS), Management Console (MC). 
Depending on network size, structure, geography and trends, one of four deploymen
models should be chosen: Fully centralized, Centralized hierarchical, Hierarchical, o
operative independent.

• Figure 1 demonstrates a Centralized hierarchical model. Refer to the HP OpenV
manual for examples of other models and for choosing the model for your needs

• Figure 2 demonstrates the HP OpenView and TEAM processes and applications
run on the collection station, the management station, and the management con

1.2.1 The Collection Station
A collection station discovers nodes and forwards this information to the manageme
station. The collection station also monitors (the netmon process) the nodes in its do
and forwards any traps it receives from the managed node (IP device) to the manag
station. Depending on the number of managed nodes and network structure, there co
more than one collection station. The collection and management stations periodica
synchronize node and topology information. Figure 1 shows two collection stations fee
node and topology information to the management station. 

1.2.2 The Management Station
The management station processes the node and topology information it receives fro
collection stations and stores the information (via ovwdb) in a database. The manag
station also receives from collection stations the trap information for various manage
nodes (ovtrapd process) and stores it. There should only be one management statio
distributed setup so that the node information can be shared by all the users on vari
management consoles. 

1.2.3 The Management Console
The management console is where all the user processes are executed. User interfa
(application) processes like ovw, xnmevents, xnmsnmpconf are executed here in ord
manage the nodes in the management station’s database. The Management Console
be connected to the Management Station using an Ethernet LAN or a high speed ne
matching the speeds of LAN. Management Station and the Management Consoles w
share the same database by mounting the database over the Network Filing System 

1.2.4 Permissions
The first network operator to run ovw and launch OpenView screens will have read/w
permissions to the database. The rest of the operators will get read-only permissions
that read-only screens do not synchronize automatically with changes in network top
or with the addition or deletion of devices to the database. To resynchronize the enti
network map, network operators on the management console must manually perform 
Map -> Refresh Map  command. All network operators will be able to perform oth
TEAM Network Management operations, such as Configuration, Provisioning, 
Diagnostics. Operators must manage a unit in the shelf from only one workstation at a
0 Release Notes for GDC Part No. 058U704-C01A
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Figure 1: Example of the Centralized Hierarchical Model
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1.3 The Distribution of Processes and Applications
The sequence of events that occur end-to-end from the IP node to the management c
(Figures 1 and 2) is as follows:

Collection Station(s)

1. netmon  process begins IP discovery, and populates the local topology 
database(ovtopmdb ) with the help of ovtopmd  process.

2. After the completion of discovery, the topology information is accessible by the 
management station.

Management Station

3. The management station requests the collection station(s) for topology informatio
ovrepld  process.

4. Upon obtaining the topology information (from all collection stations), the 
management station merges the data into its topology database. 

5. Using the data in the topology database, the processes in the management sta
communicate with each node to update other information necessary to manage
node.

6. Periodically, the ovrepld processes on the collection station(s) and managemen
station synchronize the topology data. Once synchronization is complete, only 
changes in status and topology get sent to the management station.

Management Console and Management Console X Term Server

7. After the management station is ready with node information, the ovw process c
run.

8. Once ovw is up and running, network management on various nodes can be do

Note: When one of the management consoles is also designated as a X-Term Server, 
X-Terminals (such as Tektronics Graphics terminal) could be setup to display ovw 
sessions on these terminals. The ovw sessions are actually executed on the manag
console but displayed on the X-Terminals.
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Figure 2: HP OpenView and Team Processes and Applications
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2.0 Integrating the TEAM Application in a Distributed Environment
Due to distribution of tasks in a  distributed environment, TEAM software products m
be installed on the collection station, the management station and the management c
in the precise order as described in Sections 2 and 3 of these TEAM Core Release N
The following sections describe the dependency tree, discovery, and event handling
GDC devices for TEAM software products.

2.1 TEAM Software Product Dependency
To manage any GDC product using TEAM software, multiple software products are 
required. Figure 3 shows the dependencies among various products. In the example
SC521 and SC553 cards along with their associated packages are being managed b
TEAM521 and TEAM553. Both TEAM products are dependent upon TEAM Core. 
Because of this product dependency, TEAM Core must be installed on the workstati
before installing TEAMSC521, etc. 

. 

Figure 3: TEAM Software Product Dependencies
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2.2 Discovery in an HP OpenView Distributed Environment
Once TEAM software is installed and configured in an HP OpenView NNM distribute
environment, the system is ready for network management of GDC devices. This be
with the discovery of a GDC device on the management console where it is managed.
of the typical applications that are executed on the management console are shown
Figure 2. The sequence of events that occur end-to-end is as follows:

1. A GDC device is discovered by a collection station and gets stored in its topolog
database. 

2. This discovery information is requested by the management station in a 
synchronization cycle of ovrepld  process.

3. The management station adds the device into its database as a new node.

4. Once a new node gets added on the management station, the shelf_discovery  
gets notified of the change. 

5. The Shelf_discovery  process communicates with the SCM to get the shelf 
contents and other relevant information and stores the information.

6. After a GDC shelf is discovered, a new shelf gets added to the TEAM universe 
submap.

7. From this submap various GDC devices can be managed.

2.3 Event Handling
A trap generated from a GDC device arrives at the management console where it is up
The sequence of events that occur end-to-end is as follows:

A. When SCM is set up to do so, a GDC device sends a trap to the collection sta

B. The collection station then forwards the trap to the management station, whe
gets processed by shelf_discovery  process and notifies the shelfmap pro-
cess on the management console.

C. The shelfmap process updates the status of the device associated with the e
Note that one process runs for every ovw session.
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